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DISCLAIMER

This document and the Factor Finder program have been reviewed in accordance with
U.S. Environmental Protection Agency policy and approved for publication.  Mention of trade
names or commercial products does not constitute endorsement or recommendation for use.
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PREFACE

The National Center for Environmental Assessment (NCEA), within the U.S.
Environmental Protection Agency’s (EPA) Office of Research and Development (ORD),
developed the Factor Finder program to assist exposure assessors and others in searching and
locating data contained in two previously published NCEA documents quickly and efficiently.  
The Exposure Factors Handbook (EFH) (EPA/600/P-95/002Fa, Fb, and Fc) published in August
1997, and the Sociodemographic Data Used for Identifying Potentially Highly Exposed
Populations (HEP) (EPA/600R-99/060) published in July 1999, are valuable tools for exposure
assessors, containing vast amounts of information, but time consuming for exposure assessors to
find.  In addition, data for a given population may be contained in both documents.  The Factor
Finder program was developed to help users quickly search and cross reference data contained in
both documents for populations of interest to the user.
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1.  INTRODUCTION, SYSTEM REQUIREMENTS, AND INSTALLATION

The Exposure Factors Handbook (EFH) published in August 1997 (EPA/600/P-95/002Fa,
Fb, and Fc) and Sociodemographic Data Used for Identifying Potentially Highly Exposed
Populations (HEP) published in July 1999 (EPA/600R-99/060) are two NCEA products that are
of great interest to risk assessors, risk managers, and communities concerned about exposure to
environmental contaminants.  The EFH provides guidance on selection of exposure factor values
while the HEP helps assessors identify and enumerate populations that may experience greater
exposures relative to the general population.  Both documents, however, contain vast amounts of
information including text and numerous tables, all of which can be time consuming and difficult
to locate.  The Factor Finder CD-ROM was developed to help users target specific data of
concern from the EFH and the HEP documents.  It provides a platform to perform user-friendly
queries to search the contents of each document and to locate data of interest.

Users can either enter keywords into a user-defined search box or use pull-down menus to
help pin-point specific information.  The pull-down menu features general categories such as
chemicals of concern, contaminated media, geographic region, exposure pathways and routes,
age, food categories, and activities (along with other subcategories) to name just a few.  Factor
Finder searches both documents to retrieve the data specified by the user and displays the
information on the user’s personal computer (PC) screen.

1.1.  FACTOR FINDER SYSTEM REQUIREMENTS

The Factor Finder CD-ROM requires the following hardware and software:
- CD-ROM drive,
- hard drive with at least 1 Mb of space for Factor Finder system files,
- Java 2.0, and
- Adobe Acrobat Reader version 3.0 or higher.

1.2.  INSTALLATION

Installing Factor Finder is relatively simple and does not require more than a few minutes
of time.  Please refer to Appendix A for the installation procedures for different systems.

Factor Finder is written and compiled in Java 2.0, so that any platform can run it.  If the
system is equipped with a Windows 95 or higher platform, an installation package provided on
the CD-ROM will install the Java Runtime Environment® (JRE) 2.0 from Sun Microsystems®. 
Otherwise, the Java Developer’s Kit® (JDK) 2.0 can be downloaded free from the Sun or 
Apple® Internet sites.
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The Factor Finder CD-ROM also contains the EFH and HEP in PDF format.  The user
must have Adobe Acrobat Reader® version 3.0 or higher to read these files.  Acrobat Reader®
can be obtained for free from the Adobe® Internet site.  After the Factor Finder program is
installed, Acrobat Reader® can be downloaded from the Factor Finder opening screen.

2.  EXECUTION

2.1.  FACTOR FINDER OPENING SCREEN

Once the user has begun to run Factor Finder, the opening screen (Figure 1) welcomes the
user to Factor Finder.  This screen has two menus and a number of buttons that allow access to
various Internet sites, the EFH, the HEP, and Factor Finder.

Figure 1 - Factor Finder Opening Screen
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Menus - The Factor Finder opening screen has two menus, a File menu and a Help
menu.

The File menu has a submenu selection that allows the user to exit Factor Finder (Exit).  

The Help menu has two submenu selections:  Help, which allows the user to access the
Factor Finder help screens, and About, which displays a pop-up screen with information about
Factor Finder’s creation date and point of contact.

Internet Site Buttons - Four buttons on the opening screen allow the user to access
various Internet sites, provided the user has Internet access.  Three buttons, located across the top
of the screen, allow the user to access the EPA, Office of Research and Development, and NCEA
Internet sites.  The fourth button, located at the bottom right of the screen, is the yellow “Get
Acrobat Reader” button.  In the event that the user does not have the Acrobat Reader® software
installed on his/her PC, this button will transport the user to the Adobe® Internet site to
download it.

Again, these buttons work only if the user has Internet access.  Factor Finder will search
for two popular Internet browsers, Internet Explorer® and Netscape®, on the user’s system.  If
Factor Finder cannot locate either of these Internet browsers, it will prompt the user for the
location of their Internet browser.  Once inputted, Factor Finder will take the user to the selected
Internet site.

Please note the graphics on the buttons linking to the Internet may disappear at times. 
However, the buttons remain fully functional, and the operation of Factor Finder is not affected.

EFH and HEP Buttons - These two buttons, located toward the bottom of the screen,
open Adobe Acrobat Reader® and take the user to the EFH or the HEP.  This feature is
convenient if the user knows where the desired information is located and wants to access the
documents quickly.  If Factor Finder cannot locate Acrobat Reader®, the user will be prompted
for its location before proceeding.  Once the document is open, the user can navigate through the
EFH or the HEP by clicking on the bookmarks located on the left-hand side of the document. 
Upon opening either document, the Acrobat Reader® search capability can be accessed through
the find function (button with binoculars) on the tool bar.  The user can perform searches limited
to finding occurrences of a specific word or phrase throughout the text and tables of the selected
document.  Several tables are scanned images; thus the search function will not locate terms
contained in these scanned tables.  It is also important to note that the user can exit the
documents at any time and return to Factor Finder by clicking on the “Return to Factor Finder”
bookmark located in each document.

Factor Finder Button - The user should press this button to search the EFH and HEP
using the Factor Finder search engine.  The Factor Finder search engine differs from the Adobe
Acrobat Reader® search index in that it searches the EFH and HEP tables only for criteria of
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interest.  The advantage of using the Factor Finder search engine is it considers and returns tables
for terms similar in meaning to a user-entered word.  For example, if the user inputs the term
“African American,” Factor Finder will identify the tables that also mention “Black.”  Not all
synonyms can be accounted for however.  Appendix A lists the synonyms used in Factor Finder
grouped according to the predefined categories and qualifiers (subcategories).

To close Factor Finder, the user can select Exit from the File menu, click on the X box in
the upper right-hand corner of the window, or click on the Factor Finder icon in the upper left-
hand corner of the window and select “Close” from the appearing menu.

2.2.  FACTOR FINDER SEARCH ENGINE SCREEN

After selecting the Factor Finder search engine, a new screen will appear (Figure 2.)  This
screen contains the following:

- two menus used for manipulating Factor Finder files and information,
- the search criteria section, and
- the results section.

Menus - The Factor Finder search engine screen has two menus, a File menu and a Help
menu.

The File menu has several submenu selections which can be used to open Factor Finder
files (Open Query), save Factor Finder files (Save Results), print Factor Finder searches and
results (Print Results), and exit the Factor Finder search engine screen (Exit).  Please note that
the printing feature in Factor Finder is very slow and requires a large amount of printer memory. 
It is recommended that the user save their Factor Finder search criteria and results as a Factor
Finder file, open the Factor Finder file in a word processing application, and print the file from
the word processing application.

The Help menu allows the user to access the Factor Finder help screens.

Search Criteria Section - The search criteria section consists of the Category and
Qualifier pull-down lists, the Search for... text box, and the Add to Search, Submit Query, and
Clear Query buttons.  These are the tools the user can use to build their search criteria.  Factor 

Finder conducts a case-insensitive search of the tables in the EFH and HEP based on the criteria
the user selects and inputs.

The tables in the EFH and the HEP contain various categories under which the data have
been grouped, i.e., many tables have data grouped by gender, either male, female, or both.  The
Category and Qualifier pull-down lists provide the user with a number of predetermined
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Figure 2 - Factor Finder Search Engine Screen

categories and subcategories (qualifiers) employed by tables in the EFH and the HEP.  A list of
synonyms for these categories and their corresponding qualifiers (subcategories) is provided in
Appendix B.  The user can highlight selections of these pull-down lists and press the Add to
Search button to include these categories and qualifiers as search criteria in the Search for... text
box.  The category and qualifier will then appear in the Search for... text box with an equals sign
between them, allowing Factor Finder to look in the tables where the category equals the
qualifier.

If the user selects more than one category/qualifier pair, the word OR (in ALL CAPS)
with a hard return  will appear between each category/qualifier pair.  For more information on the
logic used in conducting Factor Finder searches, please refer to the Factor Finder Search Logic
section of the user’s guide.

The user also can enter words or phrases not contained in the Category and Qualifier
pull-down lists as search criteria into the Search for... text box.  To perform this, simply enter
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the Search for... text box (by placing the curser in the box) and start typing.  Quotation marks are
not necessary.  If the user is searching for multiple words or phrases, separate the search terms
with an OR or AND (in ALL CAPS) and a hard return.  For instance, if the user were searching
for the occurrence of “residence” or “male” in the same table, then the user would enter
residence OR, hit the Enter key, and then type in male as the search criteria in the Search for...
text box.  For more information on the logic used in conducting Factor Finder searches, please
refer to the Factor Finder Search Logic section of the user’s guide.

The user also can combine the use of category/qualifier pairs and user-input words and
phrases by combining the steps discussed above for the different cases.

To remove or edit a category/qualifier pair from the search criteria, or to remove or edit
user-input text, the user must enter the Search for... text box and delete the undesired text.  To
completely clear all of the criteria and results from a Factor Finder search run, press the Clear
Query button.

NOTE:  Input of search data by selecting categories and their corresponding qualifiers
(category/qualifier pairs) from the pull-down menu may provide results that differ from those
obtained using user-input words entered into the search box.  The tables and figures of both
documents were reviewed and key category/qualifier pairs were assigned based on this analysis. 
These category/qualifier pairs were placed in a database which is searched every time a user
makes input selections from the pull-down menu.  Text from the tables and figures of both
documents also was placed in a separate searchable file.  When a user opts to search the
documents using a user-input word or phrase, Factor Finder searches this file for a match.  Every
effort has been made to reconcile differences between the two database files.  The user can input
data using either option.  However, if a Factor Finder search using the category/qualifier pairs
does not provide the user with the desired information, the user should try a Factor Finder search
using user-input words.

Once the user has finished entering the search criteria, the user presses Submit Query,
signaling Factor Finder to begin searching for the tables that meet the entered criteria.

Results Section - After Factor Finder has searched the tables in the EFH and the HEP for
the required criteria, one of two events will occur:  either Factor Finder will display a pop-up box
indicating that there were no tables in either document that met the user’s criteria, or table
numbers and table names will begin to appear in the Results of Search list.

If Factor Finder does not list any tables, the user is advised to make the search criteria
more general (i.e., if the user is searching for residence and male in a table, the user should
attempt searching for residence first and see what results occur.)

If results appear in the Results of Search list, the user can view a table by highlighting
that table in the list and pressing the Select Table button.  Factor Finder will then open Acrobat
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Reader® and the selected table will appear.  Each table will have three bookmarks listed to the
left of the table.  The first bookmark will refer to the main document (EFH or HEP) and, if
clicked, will transport the user to the main document.  The second bookmark is labeled
Discussion and, if clicked, will transport the user to the section of the main document that 
discusses the data depicted in the table.  The third bookmark is labeled Return to Factor Finder
and, if clicked, will close Acrobat Reader® and bring Factor Finder to the top of the screen.

3.  FACTOR FINDER SEARCH LOGIC

Factor Finder must use certain logic when multiple search criteria are entered to retrieve
the correct information.  Factor Finder uses the terms AND and OR (in ALL CAPS) along with
the use of parentheses ( ) to accomplish this.

• AND - used between two search terms instructs Factor Finder to look for tables
where both terms appear.

• OR - used between two search terms instructs Factor Finder to look for tables
where either term appears.

• Parentheses ( ) - used around two or more sets of search terms instructs Factor
Finder to look for tables where the criteria inside the parentheses are met first,
then search for the remaining criteria.

Parentheses are required for multiple criteria searches where AND and OR are used
together.  For instance, suppose a user entered the following search criteria:

residence AND
yardwork OR
male

Factor Finder could search for the appropriate tables in one of two ways:

1.  Search for tables with either the terms residence and yardwork, or the term male in
them.
2.  Search for tables with the term residence and either the terms yardwork or male in
them.

To alleviate this dilemma, the user should employ parentheses around the terms to search for
first.  Again, if the user wished to search for tables with either the terms residence and
yardwork, or the term male in them, the user would enter the following into the Search for...
text box:
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(residence AND
yardwork) OR
male

If parentheses are not used, Factor Finder will group multiple criteria in order of occurrence.
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Category Qualifiers Category Qualifiers Category Qualifiers
Season Spring State Alabama Employment Full Time

Summer Alaska Part Time
Fall Arizona Not Employed
Winter Arkansas Education K-8

Region North California High School
South Colorado High School Graduate
East Connecticut Undergraduate College
West Delaware College Graduate
Northeast District of Columbia Post Graduate
Northwest Florida Dermal Area Arm
Southeast Georgia Hand
Southwest Hawaii Trunk
Central Idaho Leg

Gender Male Illinois Head
Female Indiana Feet

Race White Iowa Meat Beef
Black Kansas Poultry, Other
Hispanic Kentucky Pork
Asian Louisiana Game
Native American Maine Goat
Other Maryland Rabbit

Urbanization Central City Massachusetts Lamb
Nonmetropolitan Michigan Veal
Suburban Minnesota Turkey
Rural Mississippi Chicken

Months January Missouri Eggs
February Montana Dairy Products Milk
March Nebraska Cheese
April Nevada Buttermilk
May New Hampshire Cream
June New Jersey Butter
July New Mexico Margarine
August New York Ice Cream
September North Carolina Sherbet
October North Dakota Yogurt
November Ohio Grain Products Bread
December Oklahoma Sweets

Income User Input Oregon Snacks
Age User Input Pennsylvania Breakfast Foods
Age Group Adult (18-64 years) Rhode Island Pasta

Adolescent (13-17 yr) South Carolina Cooked Cereal
Child (1-12 years) South Dakota Rice
Infant (<1 year) Tennessee Ready-to-Eat Cereal
Senior (65+) Texas Baby Cereal

Fluids / Drinks Tap Water Utah Oats
Beer Vermont Wheat
Cider Virginia Corn
Wine Washington Rye
Cold Water West Virginia Barley
Hot Water Drinks Wisconsin Sorghum
Coffee Wyoming Tracer Element - Aluminum
Tea Family Single PICA Barium
Hot Milk Type Married Couple Manganese
Cocoa Married w/ children Silicon
Fruit Juice Single w/ children Titanium
Milk Vanadium
Mineral Water Yttrium
Carbonated Drinks Zirconium
Breast Milk
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Category Qualifiers Category Qualifiers Category Qualifiers
Vegetable Artichoke Fruit Apple Fish Type Finfish

Asparagus Apricot Anchovy
Bean Banana Bass
Beet Blackberry Bluefish
Broccoli Blueberry Butterfish
Brussels Sprout Boysenberry Carp
Cabbage Cantaloupe Catfish
Carrot Casaba Cod
Cauliflower Cherry Croaker
Celery Crabapple Dolphinfish
Chard Cranberry Drum
Corn Currant Flatfish
Cucumber Elderberry Grouper
Eggplant Grapefruit Haddock
Herb Grape Halibut
Kale Honeydew Herring
Kohlrabi Kiwi Mackerel
Leek Kumquat Monkfish
Lettuce Lemon Mullet
Okra Lime Ocean Perch
Onion Loganberry Perch
Oriental Vegetable Melon Pike
Parsnip Mulberry Pollock
Peanut Nectarine Rockfish
Pea Orange Roughy
Pepper Peach Salmon
Potato Pear Sardine
Pumpkin Pineapple Sea Bass
Radish Plum Seatrout
Rhubarb Quince Shad

Raspberry Shark
Strawberry Snapper

Spinach Tangerine Sole
Squash Watermelon Sturgeon
Sunflower Fish Habitat Freshwater Sucker
Sweet Potato Estuarine Sunfish
Tomato Marine Swordfish
Turnip Chemicals of Arsenic Trout

Select Drugs / Cigarettes Concern Benzene Tuna
Substances Alcohol Cadmium Turbot

Marijuana Chloroform Whitefish
Cocaine Chromium Whiting
Smokeless Tobacco Hexachlorobutadiene Yellowtail
Crack Lead Shellfish
Inhalants Mercury Crab
Hallucinogenics Pesticide Crayfish
Stimulants Polychlorinated Biphenyl Lobster
Sedatives Polycyclic Aromatic Hydrocarbon Shrimp
Tranquilizers Tetrachloroethylene Clam
Analgesics Trichloroethylene Spiny Lobster

Vinyl Chloride Mussel
Octopus
Oyster
Scallop
Squid
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Category Qualifiers
Activity Level Sedentary

Light
Moderate
Heavy
Severe

Activity Type Employment
Household Work
Yard Work
DIY Home Project
Childcare
Goods/Services
Personal Care
Education
Organizational Activities
Entertainment
Athletics
Recreation
Passive Leisure
Transit

Location Home
School
Other Residence
Shops
In-transit
Other

Microenvironment Indoor - general
Outdoor - general
Vehicle
Autoplace
Restaurant
Indoor - Physical
Outdoor - Physical
Work/study - residence
Work/study - other
Cooking
Kitchen - other
Chores
Social
Leisure/eat - indoor
Sleep - indoor

Consumer Products Cosmetic Hygiene
Household Furnishings
Garment Conditioning
Household Maintenance
Home Improvement
Automobile-related
Personal

Water Use Shower or Bath
Toilet
Laundry
Dishwashing
Other
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APPENDIX B.  FACTOR FINDER LIST OF SYNONYMS

Category Subcategory Synonym

Race Black African American
Race White Caucasian
Race Asian Oriental
Race Native American Indian
Race Native American Eskimo
Race Native American Aleut
Race Asian Pacific
Race Asian Chinese
Race Asian Filipino
Race Asian Japanese
Race Asian Asian Indian
Race Asian Korean
Race Asian Vietnamese
Race Asian Laotian
Race Asian Cambodian
Race Asian Thai
Race Asian Hmong
Race Asian Pakistani
Race Asian Hawaiian
Race Asian Samoan
Race Asian Guamanian
Race Hispanic Mexican
Race Hispanic Puerto Rican
Race Hispanic Cuban
Gender Female Girl
Gender Female Woman
Gender Male Man
Gender Male Boy
Activity Level Light Not Very Active
Activity Level Light Not Active At All
Activity Level Moderate Somewhat Active
Activity Level Moderate Active
Activity Level Heavy Extremely Active
Activity Level Heavy Very Active
Activity Level Light Slow
Activity Level Moderate Medium
Activity Level Heavy Fast
Activity Level Heavy Hard
Activity Level Sedentary Sleep
Dermal Area Trunk Torso
Dermal Area Leg Thigh
Dermal Area Leg Calf
Dermal Area Arm Forearm
Region Southeast South Atlantic
Region Northeast New England
Region East Middle Atlantic
Region Central East North Central
Region Central West North Central
Region Central East South Central
Region Central Mountain
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Region West Pacific
Region Southwest West South Central
Region Central Midwest
Urbanization Suburban Outside Central City, 500K - 1M
Urbanization Central City Central City, 500K - 1M
Urbanization Suburban Outside Central City, 1M - 2M
Urbanization Central City Central City, 1M - 2M
Urbanization Suburban Outside Central City, 2M or more
Urbanization Suburban Outside Central City, 250K - 500K
Urbanization Rural Rural, non-SMSA
Urbanization Central City Central City, 50K - 250K
Urbanization Central City Central City, 2M or more
Urbanization Suburban Outside Central City, 50K - 250K
Urbanization Nonmetropolitan Other Urban
Urbanization Central City Central City, 250K - 500K
Meat Lamb Sheep
Grain Products Sweets Cake
Grain Products Sweets Cupcake
Grain Products Sweets Cookie
Grain Products Sweets Pie
Grain Products Sweets Doughnut
Grain Products Snacks Cracker
Grain Products Snacks Popcorn
Grain Products Snacks Pretzel
Grain Products Snacks Corn-based Salty Snack
Grain Products Snacks Tortilla
Grain Products Breakfast Foods Pancake
Grain Products Breakfast Foods Waffle
Grain Products Breakfast Foods French toast
Grain Products Bread Roll
Activity Type Education School
Activity Type Education Studying
Activity Type Passive Leisure Visiting
Activity Type Passive Leisure TV
Activity Type Passive Leisure Reading
Activity Type Passive Leisure Household Conversations
Activity Type Recreation Hobbies
Activity Type Recreation Playing
Activity Type Recreation Sports
Activity Type Employment Paid Work
Activity Type Personal Care Bathing
Activity Type Personal Care Showering
Activity Type Personal Care Washing Hands
Chemical of Concern Pesticide Fungicide
Chemical of Concern Pesticide Insecticide
Chemical of Concern Pesticide Molluscicide
Chemical of Concern Pesticide Rodenticide
Chemical of Concern Pesticide Herbicide
Chemical of Concern Pesticide Disinfectant
Chemical of Concern Pesticide Repellent
Chemical of Concern Pesticide DDT
Chemical of Concern Pesticide Chlordane
Chemical of Concern Pesticide Aldrin
Chemical of Concern Pesticide Dieldrin
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Chemical of Concern Pesticide Heptachlor
Chemical of Concern Pesticide Velsicol-1068
Chemical of Concern Pesticide Octachlor
Chemical of Concern Pesticide Chlorkil
Chemical of Concern Pesticide Ortho-chlor
Chemical of Concern Pesticide Dowchlor
Chemical of Concern Pesticide Gold Crest C100
Chemical of Concern Pesticide Topichlor 20
Chemical of Concern Vinyl Chloride Chloroethylene
Chemical of Concern Vinyl Chloride Chloroethene
Chemical of Concern Vinyl Chloride Monochloroethylene
Chemical of Concern Vinyl Chloride Ethylene Monochloride
Chemical of Concern Vinyl Chloride Monochloroethene
Chemical of Concern Vinyl Chloride VCM
Chemical of Concern Vinyl Chloride Vinyl Chloride Monomer
Chemical of Concern Benzene Benzol
Chemical of Concern Benzene Carbon Oil
Chemical of Concern Benzene Coal Tar Naphtha
Chemical of Concern Benzene Cyclohexatriene
Chemical of Concern Benzene Phenyl Hydride
Chemical of Concern Benzene Pyrobenzole
Chemical of Concern Polychlorinated Biphenyl PCB
Chemical of Concern Polychlorinated Biphenyl Arochlor
Chemical of Concern Polychlorinated Biphenyl Arochlor 1254
Chemical of Concern Polychlorinated Biphenyl Arochlor 1260
Chemical of Concern Polycyclic Aromatic Hydrocarbon PAH
Chemical of Concern Polycyclic Aromatic Hydrocarbon Acenaphthene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Acenaphthylene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Anthracene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Benz(a)anthracene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Benzo(a)pyrene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Benzo(b)fluoranthene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Benzo(g,h,i)perylene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Benzo(k)fluoranthene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Chrysene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Dibenz(a,h)anthracene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Fluoranthene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Fluorene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Indeno(1,2,2-cd)pyrene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Phenanthrene
Chemical of Concern Polycyclic Aromatic Hydrocarbon Pyrene
Chemical of Concern Chloroform Trichloromethane
Chemical of Concern Chloroform Methenyl Chloride
Chemical of Concern Chloroform Methane Trichloride
Chemical of Concern Chloroform Methyl Trichloride
Chemical of Concern Chloroform Formyl Trichloride
Chemical of Concern Trichloroethylene TCE
Chemical of Concern Trichloroethylene Trichloroethene
Chemical of Concern Trichloroethylene Ethylene Trichloride
Chemical of Concern Trichloroethylene 1-Chloro-2,2-dichloroethylene
Chemical of Concern Trichloroethylene 1,1-Dichloro-2-chloroethylene
Chemical of Concern Trichloroethylene 1,1,2-Trichloroethylene
Chemical of Concern Trichloroethylene TRI
Chemical of Concern Hexachlorobutadiene HCBD
Chemical of Concern Hexachlorobutadiene Perchlorobutadiene
Chemical of Concern Hexachlorobutadiene Dolen-Pur
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Chemical of Concern Tetrachloroethylene Tetrachloroethene
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APPENDIX C - INSTALLATION INSTRUCTIONS

INSTALLATION FOR WINDOWS 95 OR HIGHER PCs

Note:  In the following instructions, D is used to designate your CD drive.  Please change this
letter if your CD drive is a different designation.  Factor Finder was designed to work on a 800 x
600 resolution screen.

Factor Finder is a Java Version 2 program designed to run on your CD drive.  The setup
program discussed below installs an INI file in the Windows directory of your computer to let
Factor Finder know where Acrobat Reader® is on your system.  Factor Finder requires Acrobat
Reader® to view the Exposure Factors Handbook (EFH) and the Sociodemographic Data Used
for Identifying Potentially Highly Exposed Populations (HEP).  If you do not have Acrobat
Reader® on your computer, you can download it free of charge from Adobe's Internet site. 
Factor Finder also will provide you an opportunity to download Acrobat Reader® from the
Adobe Internet site.

As mentioned above, Factor Finder is a Java Version 2 program.  As such, your system
must have Java 2 to run Factor Finder properly.  The setup program contains Sun's Java Runtime
Environment (JRE) for Windows, a compact version of Java 2.  If you already have the JRE or
Java 2 installed on your system, simply finish the Factor Finder installation and click Cancel
during the JRE installation.  The Factor Finder installation program will modify the
AUTOEXEC.BAT file located on your hard drive to include the path for Java 2.  If you decide to
install the JRE in a directory other than the default directory or have Java 2 in a different location
on your system, you will have to modify your AUTOEXEC.BAT file to reflect this.  Java 2 and
the JRE are available for other operating systems.  Please see the Sun Internet site for more
details.

STEP 1: How To Install Factor Finder
1. Insert the CD into the CD drive.
2. Go to the Start button and select Run.
3. At the prompt, type in

D:\setup.exe
4. Factor Finder will begin to install itself.  Input the required information when

prompted by the setup program.
5. After Factor Finder is installed, the JRE installation program will begin to install

itself automatically.  This program enables Factor Finder to function properly.  Input
the required information when prompted by the setup program.

6. Restart your computer so that changes made to your AUTOEXEC.BAT will take
effect.
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STEP 2: How to Install JRE
Note:  You will need to perform this step only if the Factor Finder setup program does not

perform properly or if a problem arose during installation in Step 1.  To run this installation
program:

1. Locate the ff directory on your CD.
2. Open the directory.
3. Double click the file

jre1_2_2-001-win.exe
4. The JRE installation program will begin to install itself.  Input the required

information when prompted by the setup program.

STEP 3: How to Run Factor Finder
Note:  Once the program is fully installed, you will always be able to initiate the program

by following Step 3.

1. Click on the Factor Finder icon displayed on your desktop.

Printing Factor Finder

Factor Finder requires a large amount of memory to print the criteria and results of a
particular search.  This is an inherent problem with Java 2 and may result in extended periods of
time to print relatively small documents or incomplete printing.  A solution to this is to save the
search as a file and then print the file from a word processing program (i.e., Notepad,
Wordperfect, MS Word, etc.).  The manufacturers of Java are aware of this shortcoming and are
attempting to correct it.
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INSTALLATION FOR UNIX SYSTEMS

Factor Finder is a Java Version 2 program designed to run on your CD drive.  The setup
program discussed below installs an INI file in your /usr/local/bin directory to let Factor Finder
know where Acrobat Reader® is on your system.  Factor Finder requires Acrobat Reader® to
view the Exposure Factors Handbook (EFH) and the Sociodemographic Data Used for
Identifying Potentially Highly Exposed Populations (HEP).  If you do not have Acrobat Reader®
on your computer, you can download it free of charge from Adobe's Internet site.  Factor Finder
also provide you an opportunity to download Acrobat Reader from the Adobe Internet site.

As mentioned above, Factor Finder is a Java Version 2 program.  As such, your system
must have Java 2 to run Factor Finder properly.  Java Development Kit (JDK1.2) or Java
Runtime Environment (JRE) can be downloaded from the Sun Internet site.

How to Set Up Factor Finder

Note:  Usually, only a superuser has permission to copy files into your /usr/local/bin.  If so, ask
your system administrator to install it for you.)

1. The user needs Java Development Kit (JDK1.2) or Java Runtime Environment (JRE)
to run Factor Finder.  JDK or JRE can be downloaded from

http://java.sun.com/cgi-bin/java-ports.cgi
(Please set the path for JDK before running Factor Finder.)

2. Copy factfind.ini from the CD to /usr/local/bin.

3. Factor Finder needs Acrobat Reader® to display pdf files.  You can find out if your
PC has the Acrobat Reader® (acroread or xpdf or others) by typing:

>where acroread (or xpdf)
or
>which acroread (or xpdf)

The system will display whether Acrobat Reader is found by:
>/usr/bin/acroread (or /usr/bin/xpdf)
>acroread: Command not found. (or xpdf: Command not found.)

/usr/bin is the directory where Acrobat Reader® is found.  If the machine does not
have Acrobat Reader®, you can download it from

http://www.adobe.com/products/acrobat/readstep.html 
before running Factor Finder or download it when Fact Finder is running.

There are two ways to set up the path for Acrobat Reader®.
1. Type in the path for Acrobat Reader® in factfind.ini (make sure that you have

permission to write to this file.)
[Unix] -------> [Unix]
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key1= key1=/usr/bin/acroread
2. Run Factor Finder to locate Acrobat Reader®.  The program will write the path into

factfind.ini after the you locate the reader.  (If only a superuser has permission to
write to /usr/local/bin, the permission will be denied for ordinary users.) 

How to Run Factor Finder
1. For the first time user:

>cd
>mount /mnt/cdrom
>cp /mnt/cdrom/factfind_run
>factfind_run

2. For the experienced user:
>cd
>mount /mnt/cdrom
>factfind_run
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